Chapter 2. Using This Document & Getting Help



This document is organized in two dimensions;
	From the GUI (Graphical User Interface) explaining the available options and their functions,
       with links to deeper descriptions and usage.  Chapter 4, GnuCash Windows & Menus Options Overview

	By classifying Operations, Tasks, or Functions based on whether it is an Account, Transaction,
       Reporting or other oriented operation. 
       Examples are;
	 Account Actions - Chapter 5, Setting Up, Editing & Working with Accounts

	 Transaction/Register Actions - Chapter 6, Common Transaction Operations

	 Tools and Assistants - Chapter 8, Tools & Assistants

	 Reporting & Charting - Chapter 9, Reports And Charts

	 Customization - Chapter 10, Customizing GnuCash






Accessing Help



This window is accessed by going to the Help menu and selecting either the Tutorial and Concepts
     Guide or the Contents (F1).  the section called “Account Tree - Help Menu”
The Help Window has a Toolbar for navigation. The Toolbar is described below;
	Back Used to navigate to topics previously viewed. 

	Forward Used to navigate to topics previously viewed.

	Help Used to access various GNOME Help files.

	Search Enter search term to search GNOME Help files.  Does not search GnuCash
        Help file.



The right side of the Help Window displays the currently opened help page. The left side of the Help
     Window contains the help Topics list tab. Selecting one of the help topics will load that page on the right
     side.


GnuCash Tutorial and Concepts Guide



This guide is the counterpart to this help. It explains the concepts used in GnuCash and has a tutorial
      that takes you through using GnuCash to manage your accounts. It will appear if you choose
      Open the new user tutorial in the
      Welcome to GnuCash! menu.
To open this Guide manually go to Help → Tutorial and Concepts Guide.
It is strongly recommended to read this guide if you are new to
      GnuCash or unfamiliar with accounting concepts.

New Account Hierarchy Setup



This assistant helps you to create a set of GnuCash accounts. It will
      appear if you choose Create a new set of accounts
      in the Welcome to GnuCash! menu.
This will create a new blank GnuCash file and then automatically start
      the New Account Hierarchy Setup assistant.
Tip
To start this assistant manually, go to File → New if you need to create a new file.
        If you want to run the assistant within the opened file, go to
        Actions → New Account Hierarchy...
        when the accounts tree tab is displayed.

	The New Account Hierarchy Setup assistant opens
      with a screen that briefly describes what this assistant does. The three
      buttons at the very bottom of the screen will not change while using the
      assistant.
	Cancel — exit the process and cancel creating
        a new set of accounts.
Warning
If you click this button, any selections you have made up to
          this point will be lost.


	Back — brings up the previous screen so
        that you can change a previous selection until the first screen.

	Forward — brings up the next
        screen so you can continue through the assistant.




	The next screen allows you to Choose Currency
      to use as default for your accounts.
	The Currency: drop down list defaults to the currency
          configured in the Accounts tab under
          GnuCash Preferences (see the section called “Accounts”). If you wish your accounts to
          use a different default currency, select one from the list.

	The Forward button is used to confirm
          your selection and continue to the next screen.




	The next screen is used to Choose accounts to create.
You will see a screen divided into three parts.
	The left upper portion has a list of
          Categories for commonly used hierarchies of
          accounts. Select from this list the types of accounts you wish to
          use. You can select as many of the categories of accounts as you
          wish.

	The left lower section has a Category
          Description that displays a detailed description of the
          category currently highlighted.

	The right side has a list of the Accounts
          that will be created from the selected category.

	The Select All button allows you to
          include all of the account categories.

	The Clear All button allows you to
          deselect all of the categories selected.




	The next screen allows you to Setup selected accounts
      by entering the opening balances and by selecting if the account is a placeholder.
Note
Equity accounts do not have opening balances so the
        opening balance value for this kind of accounts
        is locked and set to zero by
        GnuCash

Note
Placeholder accounts are used to create a hierarchy of accounts and
        normally do not have transactions or opening balances.

Follow the instructions in the display on how to select the
      account and entering an opening balance for the account. A single
      click is used to highlight an account.
	The left side of the screen has a list of Account
          Names. Select an account by "clicking" once in the
          Account Names column with the account highlighted. This will open
          the account name for changes.

	The right side of the screen has a check-box to make an
          account a Placeholder and a box to add the
          Opening Balance for the selected account. Again
          a single click in the Opening Balance or
          Placeholder column will
          open the field for changes.




	The Finish account setup is the last screen and
      gives you a final list of the three choices to finish the assistant.
	Cancel — exits the assistant and cancels creating
        a new set of accounts.
Warning
If you click this button, any selections you have made up to
          this point will be lost.


	Back — brings up the previous screen so
        that you can change a previous selection until the first screen.

	Apply — creates the accounts you have selected.






You should now have a hierarchy of accounts in your main GnuCash
      account window.

Business Windows



Customers Overview



To open the Customers Overview window, click
            Business → Customer
             → Customers Overview.
Table 4.35. Customers Overview - Toolbar Buttons
	Toolbar Buttons
	Description

	New
	Create a new customer

	Edit
	Edit the selected customer

	New Invoice
	Create a new invoice (by default it is for the selected customer)

	Customer Listing
	Show customer aging overview for all customers





Table 4.36. Customer context menu
	Context menu item
	Description

	Rename Page
	

	Edit Customer
	Edit the selected customer

	New Invoice
	Create a new invoice

	Customer Report
	Show customer report





Note
The customer context menu appears if you right click on a customer in the list.


Vendors Overview



To open the Vendors Overview window, click
            Business → Vendor
             → Vendors Overview.
Table 4.37. Vendors Overview - Toolbar Buttons
	Toolbar Buttons
	Description

	New
	Create a new vendor

	Edit
	Edit the selected vendor

	New Bill
	Create a new bill (by default it is for the selected vendor)

	Vendor Listing
	Show vendor aging overview for all vendors





Table 4.38. Vendor context menu
	Context menu item
	Description

	Rename Page
	

	Edit Vendor
	Edit the selected vendor

	New Bill
	Create a new bill

	Vendor Report
	Show vendor report





Note
The vendor context menu appears if you right click on a vendor in the list.


Employees Overview



To open the Employees Overview window, click
            Business → Employee
             → Employees Overview.
Table 4.39. Employees Overview - Toolbar Buttons
	Toolbar Buttons
	Description

	New
	Create a new employee

	Edit
	Edit the selected employee

	New Voucher
	Create a new voucher (by default it is for the selected employee)





Table 4.40. Employee context menu
	Context menu item
	Description

	Rename Page
	

	Edit Employee
	Edit the selected employee

	New Voucher
	Create a new voucher

	Employee Report
	Show employee report





Note
The employee context menu appears if you right click on a employee in the list.



Creating a Chart of Accounts



The Chart of Accounts is like a table of contents for your finances. The best
        way to conceptualize a chart of accounts is as a tree. The main branches represent
        entire categories or groups, while the leaves of the tree denote individual bank
        accounts or expense categories. When a summary report is requested, typically only
        the main branches are shown in the report, rather than the individual accounts. For
        example, a chart of accounts might look like the following:


        300             Expenses

         |

         +--310         Living Expenses

         |   |

         |   +--311     Beer

         |   |

         |   +--312     Cable

         |

         +--320         Business Expenses

         |   |

         |   +--321     8-inch Floppies

         |   |

         |   +--322     Blue Ray RW DVDs

         |   |

         :   :



Accounts codes
Note that accounts not only have names; they may have codes, to order the accounts.
          When a report is generated, the sort order is determined by the numbering. It’s
          customary to have the leaf accounts end in non-zero digits, while parent nodes have
          increasing numbers of zeros.

Warning
GnuCash does not prevent duplicate numbering, although we would encourage you
          to avoid this. Account codes are treated as numbers in base-36, thus, if you run out
          of numbers, you can use the letters, a through z.


Multiple Currency Transactions



Currently transfers between different currencies are only supported by using the Transfer Funds
         window described above (the section called “Transfer Funds window ”). It is necessary to use this dialog
         to add an exchange rate.
To setup an account as a different currency edit the account properties and change the Commodity
         field to the foreign currency. This account will now enable the Currency Transfer pane in the
         Transfer Funds window .

Jump to another Account Register



When using the Account Register Window it is frequently useful to be able to
      view another account and also the transfer account at the same time. GnuCash allows you to
      do this quickly by using the Jump button available in the Toolbar or
      the Actions → Jump menu item in the Account Register Window. 
Select the transaction in the Account Register Window and either click the Jump icon or select
      Actions → Jump to open the Account Register Window 
      target. If the transaction is split
      between more than one transfer account then you will need to show all the split transfer accounts first and
      select the transfer account to jump to.

Edit Scheduled Transaction Window



The Edit Scheduled Transaction Window is divided into a Name area, Options area, Occurrences area,
        Recurrence Frequency area, mini calendar and Template Transaction pane.
The Name field is used to enter the name for the scheduled transaction. This will be
        used in the Description of the transaction.
The Options area contains check-boxes to set if the transaction is
        automatically created and how many days in advance the transaction is created and/or a reminder posted.
       
The Occurrences area contains selections to set for dates limits on
        transactions to be entered or the number of transactions to be entered.
The Recurrence Frequency area contains selections to set how
        often the transaction is scheduled to be added and on what dates this occurs.
The mini calendar provides a visual indication of what transactions are already scheduled.
The Template Transaction pane allows you to setup the transaction
        as you would like it to be entered into the register.
These options are described in more detail in the section called “Scheduling Transactions”
	From the Scheduled Transaction tab selecting a transaction from the list and pressing
          the Edit or New buttons will bring up the Edit Scheduled Transaction Editor.




Customers



Customers are people or companies to whom you sell goods or
    services. They must be registered within the A/R system.
New



To register a new customer, enter the menu Business → Customer → New Customer. Fill in customer information, such as
      Company Name, Address, Phone, Fax, etc. Below is a list of the other
      options:
	Identification - Customer Number - can be
          any number by which you would like to refer to this customer. You
          may leave it blank and a number will be chosen automatically. 
          See the section called “Counters Book Options Tab” for more info.

	Identification - Active - differentiates
          active customers from inactive ones. This is useful when you have
          many past customers, and you want to see only those marked
          active.

	Billing Address - Name - is the contact
          name of the person to receive the invoices.

	Notes - records any additional comments
          about the customer.

	Billing Information - Currency -
          specifies the default billing currency.

	Billing Information - Terms - specifies
          the default billing terms for this customer. Billing terms must be
          preregistered using Business → Billing Terms Editor.

	Billing Information - Discount - gives
          the customer a default percentage based discount at the time of
          invoice creation. Enter a value from 0 to 100. You can override the
          default discount when you create an invoice.

	Billing Information - Credit Limit -
          stores the maximum credit you are willing to extend to the customer.
          This field is for your reference purposes only. GnuCash does not use
          the value.

	Billing Information - Tax Included - this
          specifies whether nor not tax is included in invoice amounts by
          default. You can choose Yes,
          No, or Use Global.
          
	Yes means that the tax is already
                included in amounts on invoices.

	No means tax is not
                included.

	Use Global means to use the setting
                made in the global preferences accessible through
                Edit → Preferences
                (Gnucash → Preferences on Mac OS X).




	Billing Information - Tax Table -
          specifies a default tax table to apply to invoice line items. Tax
          tables must be registered from the Business → Tax Table Editor menu item.

	Shipping Address - records the customer’s
          shipping address if it is different from the billing address. The
          shipping address is for your reference. GnuCash does not use the
          value.




Find and Edit



To search for an existing customer, use the Business → Customer → Find Customer window. You select a customer to
      View/Edit from the results of the search. This
      window is also used to look up customers when creating invoices and
      processing payments.
If many customers match the search criteria you provide, the
      search can be refined by running an additional search within the current
      results. The current result set is searched when the Refine
      Current Search radio button is selected. In fact, GnuCash
      selects this option for you after you run the initial search.
If the customer you are searching for does not match the supplied
      search criteria, change the search criteria, click the New
      Search radio button and then the Find
      button. The relevant step is the New Search
      selection. If the customer is not in the result of the original search,
      and you only search within this set, the customer cannot be found,
      regardless of new search criteria.
Note
To return a list of all registered active customers, set the
        search criterion to matches regex, and place a
        single dot "." in the text field area. Make sure Search only
        active data is checked, then click
        Find. The regular expression "." means to match
        anything.



Process Payment



Eventually, you will receive payment from your customers for
    outstanding invoices. To register these payments, use the Process Payment
    application found in Business → Customer → Process
    Payment.
The Process Payment application consists of:
	Payment Information - Customer - the
        customer who paid you. If you remember the company name
        you entered in the New Customer window for this customer,
        start to type it in this field and GnuCash will try auto complete 
        it for you. Else, press the Select... button to access the Find
        Customer window described in the section called “Find and Edit”. Highlight the customer 
        you are looking for with a click in the search results, then press the 
        Select button.

	Payment Information - Invoice - the invoice
        for which payment was received. If you remember the invoice ID,
        start to type it in this field and GnuCash will try auto complete 
        it for you. Else, press the Select... button to access the Find
        Invoice window described in the section called “Find”. Highlight the invoice 
        you are looking for with a click in the search results, then press the 
        Select button.

	Payment Information - Date - the date you
        you received payment.

	Payment Information - Amount - the amount
        of money received.

	Payment Information - Num - the check
        number.

	Payment Information - Memo - any comments
        about this payment.

	Post To - the A/Receivable account to which
        to post this transaction.

	Transfer Account - the account where the
        money will be deposited (a checking account for example).




Security Editor



The Security Editor is used to create and edit commodities that are used by mutual fund and stock
      type accounts. It also shows the details of National Currencies that are used by GnuCash.
To show the details for National Currencies click the Show National Currencies
      check-box at the bottom of the screen.
Each entry in the editor shows the details used by the security/currency:
	Type: Categories for organizing securities. GnuCash has the following built in:
	CURRENCY or ISO4317: These are used for national currencies and are not editable with the Security Editor.

	FUND: Ordinarily used for open-ended mutual funds, i.e., those that one purchases from and sells to only the issuing company and that are priced daily at their net asset value.

	AMEX, ASX, EUREX, NASDAQ, and NYSE: These represent a few of the exchanges on which stocks, closed-end mutual funds, and exchange-traded funds are traded.

	Template: This is a reserved word. It will not normally appear in the Security Editor unless you type it in, and if you do it will cause problems. Don't use it.



If your investment doesn't fit into one of these categories, for example if you trade stocks on the DAX or LSE, you can easily create your own type simply by typing it into the field. The type of security has no meaning to Gnucash (except Template, don't use that!), it's there only to make it easier for you to find the security from the selection lists.

	Symbol: Indicates the symbol or abbreviation for the
         commodity. This is usually the ticker symbol (for stocks) or other unique abbreviation for the commodity.
         If the commodity is traded on any public exchange, it is important to use the same identifier
         used on that exchange. For national currencies the symbol is the ISO-4217 currency code.

	Name: The full name of the commodity is a recognizable name
         such as US Dollars or IBM Common Stock.

	Code: This is any numeric or alphanumeric code that is used
         to identify the commodity. The CUSIP code is a unique identifying numeric string that is associated with
         every stock, bond or mutual fund, and most kinds of traded options, futures and commodities. This code is
         not required.

	Fraction: This is the smallest traded unit of the commodity,
         expressed as a fraction of a single nominal unit. This unit is used by GnuCash accounts as the default
         fraction for trades in the commodity.



Adding or Editing a Commodity



To add a new commodity (stock, or mutual fund), click on Add, and enter the
        details of the commodity into the New Security dialog box. To edit an
        existing commodity, select the commodity from the Commodities list, click the Edit
        button, and edit the Edit Security dialog box.  To remove a commodity,
        select the commodity and click the Remove button.
The fields in the New/Edit Security screens are the same as defined for the Security Editor 
        the section called “Security Editor”.  Below these fields are the options for Online Quotes.

Configuring Securities/Currencies for On-Line Retrieval of Prices



To support on-line quotations for a particular stock or mutual fund account, you must first enable
        on-line price quoting and select a price source in the Security Editor. Online currency quotes require 
        only that the check-box for Online quotes and the timezone be selected, and that the “Get Quotes”
        box be checked in the Security Editor.
Detailed instructions are in the section on Creating New Accounts.
         the section called “Steps to enable On-line price updating”


Chapter 9. Reports And Charts



Note
This section is a “work in process” all of the material has not been reviewed for V2.0.
      While it may not be strictly accurate, it is at least a "guide".

Reports and Charts give GnuCash the ability to present an overview of financial
    data in various ways. This can range from a simple summary of account totals to an
    advanced portfolio view. This section will present an explanation of the main GnuCash
    reports and how to adjust them.
GnuCash has classified the main types of reports into four major classes. These
    are all available under the Reports menu.
General Reports



The General Reports include the Account Summary Report, Custom Reports, the Tax Schedule Report and TXF Export, and the Transaction Report and also the reports in the Sample & Custom menu.
	Account Summary:

	Tax Schedule Report and TXF Export: The tax schedule report lists all taxable income and deductible expense amounts used in the preparation of US Income Tax returns. The purpose of the report is to provide a complete audit trail for these amounts. The report is intended to be used by a tax payer to manually prepare his or her own tax return, or alternatively, to be provided to a tax preparer for that purpose. The report can also be used to generate an export of all tax related income and expenses to a TXF (Tax eXchange Format) file (this is in addition to exporting to the HTML format that all reports allow). The TXF file can be imported into tax filing programs such as TaxCut or TurboTax. The report should be run, inspected carefully for errors or omissions, and then corrections made to transactions, report settings, currency conversion rates or the account structure as needed. This process should be repeated as often as needed until all the amounts on the report are correct before a final version is used and saved along with the tax returns.
 For accounts specified in the report options (none = all) that are also flagged as Tax-related, all transactions for the time period selected (also in the report options) are included. The report sorts transactions by date within account providing subtotals by account within tax code within Form or Schedule line number. Support is also provided for multiple copies of and for sub-line items for selected Forms/Schedules. Optionally uses special date processing to include federal estimated tax payments after year end.
All totals are in USD since this is the currency required for filing US Income Tax returns. Non-USD transaction amounts are converted to USD using the transaction conversion rate to USD, if available. If not, a conversion rate from the price database is used (either the date nearest the transaction date or nearest the report date as specified in the report options; if none is available, transaction amounts are converted to zero and the report provides a comment accordingly). A complete audit trail of conversions is provided.
Note
For this to work, the user has to segregate taxable and non taxable
           income to different accounts, as well as deductible and non deductible expenses.
           The Income Tax Information dialog is used for this. To access the Income Tax
           Information dialog go to Edit → Tax Report Options. The user
           also must set the TXF category of each tax related account. The Income Tax
           Information dialog is described in the the section called “Setting Tax Report Options” section.


	Transaction Report:

	Welcome Sample Report:

	Custom Multicolumn Report: This report is used to place multiple reports
           into a single report window to examine a set of financial information at a glance.

	Sample Graphs

	Sample Report with Examples:





Assets & Liabilities



The Assets & Liabilities reports includes the Balance Sheet             report, Investment reports and the Net Worth report.
	Advanced Portfolio:
Columns
	Account — Stock Account

	Symbol — Ticker Symbol/Abbreviation as defined in the Security Editor. A report option can suppress this column.

	Listing — Type as defined in the Security Editor. A report option can suppress this column.

	Shares — Number of shares           (quantity). A report option sets how many decimal places to show.
	    A report option can suppress this column.

	Price — Unit market price as at report date. A report option can suppress this column.

	Basis — Cost of all shares acquired by any means, including brokerage fees if the option to include them is checked. Report option Basis calculation method can be set to Average, LIFO or FIFO.

	Value — Number of shares * Unit market price as at report date

	Money In — Sum of the cost of stock purchased, excluding stock acquired as part of a Dividend Reinvestment Plan. I.e. External money used to purchase shares.

	Money Out — Money from selling shares or a spin off transaction.

	Realized Gain — Money received for selling shares minus basis for shares sold, minus brokerage fees for the sale if the option to include them in basis is checked.

	Unrealized Gain — Value less Basis for unsold shares

	Total Gain — Realized Gain + Unrealized Gain

	Rate of Gain — Total Gain / Money In * 100 (from GnuCash 2.6.1 onwards)

	Income — Total of all income transactions associated with a stock account.
Note
To include income from dividends which are not reinvested:
Ensure there is a dummy transaction split to the stock account with quantity 0 price 1 value 0 in the dividend transaction. You can just enter the dummy stock split with no values in the dividend account and it will create the transaction with price 1 even though you cannot see the Price column in that register.


	Brokerage Fees — Brokerage Fees

	Total Return — Total Gain + Income

	Rate of Return — Total Return / Money In * 100



Common report options are described in the section called “Customizing Reports and Graphs”
Report Specific Options
	Accounts Tab
	Include accounts with no shares — Unchecked (default) or checked.




	Display Tab
	Show ticker symbols — Checked default) or unchecked. If unchecked, Symbol column will be omitted.

	Show listings — Checked (default) or unchecked. If unchecked, Listing column (source of shares price quotes) will be omitted.

	Show number of shares — Checked (default) or unchecked. If unchecked, Shares column will be omitted.

	Share decimal places — The number of decimal places to show in the number of shares. Default is 2.

	Show prices — Checked (default) or unchecked. If unchecked, Price column will be omitted.




	General Tab
	Price Source — Nearest in time (default) or Most Recent.

	Basis calculation method — Average (default), FIFO or LIFO.

	Set preference for price list data — Checked (default): Use price list data. If there is no relevant price list data, transaction prices will be used and there will be a warning. Unchecked: Get prices from stock transactions.

	How to report brokerage fees — Include in basis (default), Include in gain or Ignore.







	Asset Barchart:
The Asset Barchart report displays bars that present the value of all assets in a
        GnuCash file over time.  By default, the report shows all accounts
        in Accounts Receivable, Current Assets,
        Fixed Assets, Investments and Special Accounts
        (if they exist) and it displays monthly bars for the current financial period. 
        This report provides a graphic view of the assets in the file over time.
Tip
Like all the generic reports, the user can assign a title and save the report with 
          it's selected options for re-use later.

The display is in the form of either a stacked barchart or simple barchart with an 
        option to display a table of the values.
This report calculates and displays a default of 8 bars or up to 24 separate asset
        accounts value at the end of the day on several dates through a specified time period.
        The report automatically selects the most significant accounts to display with all other
        selected accounts summed as Other.
The report exploits the outline structure of the chart of accounts to allow the user
        to select top level accounts and sub-accounts down to a user-selectable depth.  Selected 
        sub-accounts below the selected depth are automatically summed up into
        the next level when it is also selected.  The default number of sub-account levels is 2,
        giving a summary view.  Increasing the number of sub-levels increases the detail available
        to display. It is possible to un-select a higher level account and leave sub-accounts 
        selected to force greater detail to appear in the report.
By default the report includes all asset accounts and sub-accounts,
        as well as Imbalance and Orphan Special accounts
        in whatever currencies or commodities may be present. The report's base currency is the 
        default currency of the GnuCash file but if the file has data
        for multiple currencies, then it can be changed to another currency.
Since each account may be individually selected, the report can be designed to focus 
        on a small subset of data such as current assets or investments.
The overall interval of the report defaults to start at the start of the current 
        accounting period and to end at the end of the current accounting period. Numerous 
        other starting choices and ending choices are available.
The first bar shows the selected values at the end of the day on the first date chosen.
        There are a number of choices for step size from day to 
        year with the default being month. Note that if any 
        step date would fall on the 29th, 30th or 31st in a month that does not have such a date
        the next interval will be 31 days later. For that step only the date will slip
        up to 3 days into the following month. This is true for releases at least through 2.4.13.
        Bug 639049 is open in Bugzilla to modify this behavior.
Currently, there is no option to start the report on the last day of any period. 
        There is also no option to show beginning balances or end of 
        previous step balances. This makes it difficult to correlate this report to 
        business quarterly reports, for example.
The Net Worth linechart report, Liability barchart report and Net Worth barchart 
        report are similar except for the graphic type and default account groups selected.
Other features are customizable in a manner similar to other standard reports.

	Asset Piechart:

	Average Balance:

	Balance Sheet: This report summarizes assets, liabilities, and equity.
         When properly maintained, assets should equal the sum of liabilities and equity.
         If that is not the case, there is some kind of internal imbalance in the
         accounts.

	General Journal:

	General Ledger:

	Investment Portfolio: This report summarizes the value of the stocks in
         the current portfolio.

	Liability Barchart:

	Liability Piechart:

	Net Worth Barchart: Net worth is the difference between the value of assets
         or liabilities.

	Net Worth Linechart: Net worth plotted over time.  Net worth is the difference between the value of assets
         or liabilities.

	Price Scatterplot:




Creating Reports and Graphs



Note
This section may need updating !!!

It is possible to write reports if the current ones are not suitable. To do this
         you will need to know Scheme (a LISP-like programming language), and it is an
         excellent idea to have a copy of the GnuCash source code available. 
The reporting interface is documented in the source code file
         src/report/report-system/doc/report-html.txt. The file src/report/utility-reports/hello-world.scm
         in the GnuCash source distribution provides a good example of how reports are
         developed.
It is also necessary to access data from the engine to get information for your
         report. This is performed by a set of Scheme wrapper functions that are documented in
         the file src/g-wrap/gnc.html. Examine some of the other reports in src/scm/report for
         an indication of how they are used.
At present, reports are produced by calling a HTML-generation API, which outputs
         a dialect of HTML and rendering this with a HTML widget. This has limitations,
         particularly when trying to align objects precisely, as might be necessary for
         printing onto pre-printed invoices for example.

Setting Preferences



The GnuCash Preferences window allows you to customize your GnuCash 
    session by setting several options. From the GnuCash menu
    select Edit → Preferences
    (GnuCash → Preferences on Mac OS X).
    The GnuCash Preferences window will open. 
    Using the tabs on the left make your desired changes. The settings in
    this dialog are set per user and not stored with the file. This is
    in contrast to the settings described in the section called “Book Options”,
    which are kept with, and are part of, the file (or Book), and as such are
    common to all users. So GnuCash Preferences settings are
    individual to each user who uses a given file and any changes made by one
    user will not affect other users of that file. Also, a given user's
    preferences will be common to all files that that user opens with
    GnuCash.
Tip
Pausing the cursor for a couple of seconds over options in these windows
      will display a tooltip with in-depth information on the choice.

Note
The changes you make will be applied at once.

To close the GnuCash Preferences window press the
    Close button.
Each tab in the GnuCash Preferences window is
    discussed in its own section below. For a listing of the tabs, see
    Chapter 10, Customizing GnuCash.
Accounting Period



Figure 10.1. The Preferences — Accounting Period tab
[image: The Accounting Period tab]




	Start Date — This item sets the accounting period’s start date.
	Relative — Use the specified relative starting date for profit/loss
                calculations.  Also use this date for net assets calculations.  Relative defines
                start by today or start of current/previous year, quarter, month.

	Absolute — Use the specified absolute starting date for profit/loss
                calculations.  Also use this date for net assets calculations.




	End Date — This item sets the accounting period’s end date.
	Relative — Use the specified relative ending date for profit/loss
                calculations.  Also use this date for net assets calculations.

	Absolute — Use the specified absolute ending date for profit/loss
                calculations.  Also use this date for net assets calculations.




	Summarybar content
	Include grand total — If checked, show in the Summarybar a grand total of all
              accounts converted to the default currency.

	Include non-currency totals — if this
              option is selected, GnuCash will include in the Summarybar a total 
              for non-currency items (for instance number of shares).







Accounts



Figure 10.2. The Preferences — Accounts tab
[image: The Accounts tab]




	Separator Character — The account
          separator is the character that separates a parent account from its
          sub-account, for example Utilities:Electric. The default is a
          : (Colon), but you can also select
          / (Slash),
          \ (Backslash), — (Dash)
          or . (Period), or any Unicode character 
          that isn’t a letter or a number.

	Reverse Balanced accounts — This option
          lets you determine whether account balances will display as positive
          or negative numbers:
	Income & Expense assigns a
                positive credit balance to income account balances and a
                negative debit balance to expense account balances. See
                the section called “Types of GnuCash Accounts” for more information 
                on these account types.

	Credit accounts (default) displays
                a positive balance for account types that would normally carry
                a credit balance (income, credit, liability, equity). See
                the section called “Types of GnuCash Accounts” for more information on 
                these account types.

	None shows all credit balances as
                negative and all debit balances as positive.




	Labels — Select this option if you want
          column headings in the register to refer to debits and 
          credits instead of the default informal headings such
          as withdrawal
          and deposit.

	Default Currency — This item determines
          which currency will be selected by default when creating new
          accounts.
	Locale — Use the system locale currency for 
              all newly created accounts.

	Choose — specify the
              currency to use, independent of your system
              settings.




	Account Color — This option
          lets you manage the display of the account color set in the 
          Edit Account window:
	Show the Account Colors as background — show the
                accounts color as account name background in the Accounts Page.

	Show the Account Colors on tabs — show the accounts 
                color as background in the account register tabs.







Business



Figure 10.3. The Preferences — Business tab
[image: The Business tab]




	General
	Enable extra buttons — If checked,
              extra toolbar buttons for common business functions are shown.

	Open in new window — If checked, each
              invoice will be opened in its own top level window. If clear, the
              invoice will be opened in the current window.

	Accumulate splits on post — Whether
              multiple entries in an invoice which transfer to the same account
              should be accumulated into a single split by default.




	Invoices
	Report for printing: — Allows to select
              the invoice report to be used for printing.

	Tax Included — Whether tax are
              included by default in entries on invoices. This setting is
              inherited by new customers and vendors.

	Auto pay on posting — If enabled, at post 
              time automatically attempt to pay customer documents with outstanding 
              pre-payments and counter documents.
Note
Counter documents are documents with 
                opposite sign. For example for an invoice, customer credit notes and negative
                invoices are considered counter documents.
The pre-payments and documents obviously
                have to be against the same customer.





	Bills
	Notify when due — Lets you set whether
              you want to be notified at GnuCash startup 
              of when a bill is soon to be due.

	Days in advance — How many days before 
              the due date to warn about bills coming due.

	Tax Included — Whether tax are
              included by default in entries on bills. This setting is inherited
              by new customers and vendors.

	Auto pay on posting — If enabled, at post 
              time automatically attempt to pay vendor documents with outstanding 
              pre-payments and counter documents.
Note
Counter documents are documents with 
                opposite sign. For example for a bill, vendor credit notes and negative
                bills are considered counter documents.
The pre-payments and documents obviously
                have to be against the same vendor.








Date/Time



Figure 10.4. The Preferences — Date/Time tab
[image: The Date/Time tab]




	Time Format
	Use 24-hour clock — Lets you specify if you
              want to use 24 or 12 hours time format. That is if 11 o’clock at 
              night should be represented as 11PM or 23:00.




	Date Format — This option controls the
          appearance of the date (you could see a preview of the date beside any of the choices).
          The available choices are:
	US — Use the date format common in the United States.

	UK — Use the date format common in the United Kingdom.

	Europe — Use the date format common in continental Europe.

	ISO — Use the date format specified by the ISO-8601 standard.

	Locale — Use the date format specified by the system locale.




	Date completion — This option
          lets you manage the case when a date is entered without a year: 
            
	In the current calendar year (Default) — Dates will be completed so that 
                they are within the current calendar year.

	In a sliding 12-month window starting a configurable number of months before 
                the current month — Dates will be completed so that they are close to the current 
                date. You can enter the maximum number of months to go backwards in time when completing dates.




          




General



Figure 10.5. The Preferences — General tab
[image: The General tab]




	General
	Display "Tip of the Day" dialog — This option displays or hides the 
              Tip of the Day screen when GnuCash is started.

	Show splash screen — With this option you
              can enable or disable the visualization of the startup screen while
              GnuCash is starting up.

	Perform account list setup on new file —
              This option turns off the display of the New Account
              Hierarchy Setup assistant when the entry File → New File is selected from the 
              GnuCash menu.

	Set book option on new files to use split "action"
              field for "Num" field on registers/reports —
              If selected, the displayed setting on the New Book
              Options dialog for the Use Split Action Field
              for Number setting will be selected and, if saved, the
              book option for the new file will be set so that
              the "Num" field on registers shows/updates the split-action field
              and the transaction-num field is shown on the second line in
              double line mode (and is not visible in single line mode).
              Otherwise, the displayed setting on the dialog will not be
              selected and, if saved, the book option for the new file will be
              set so that the "Num" field on registers shows/updates the
              transaction-num field. See the discussion in the section called “Book Options” about how to set book options including
              the option for the section called “Use Split Action Field for Number”.
              Regardless of the setting of this preference, the
              user can modify the initially displayed setting for this option on
              the New Book Options dialog before saving the
              options.



Note
If the New Book Options dialog appears
              in situations where a new book is being set up, the settings from
              this preference will determine the default setting for the
              corresponding check box on the dialog. However, the
              OK button on the New Book
              Options dialog must be pressed for the setting to be
              made for the new book; otherwise it will default to not
              selected.


	Numbers
	Display negative amounts in red — If you
                turn off this option, GnuCash will display negative numbers in
                black.

	Automatic Decimal Point — This option
                will automatically insert a decimal point into numbers you type
                in.

	Decimal Places — This field allows you
                to set the number of decimal places to be used.




	Files
Note
The following options are only relevant for files saved in XML format.

	Compress files — This option determines
              whether the GnuCash data file will be compressed or not.

	Show auto-save confirmation question —
              If this option is enabled, GnuCash will show you a confirmation screen
              each time the auto-save process is started.

	Auto-save time interval —
              This field sets the number of minutes between each automatic saving of the file.
              Set to 0 to disable the auto-save feature.

	Enable timout on "Save changes on closing" question —
              If enabled, the Save changes on closing question will only wait a 
              limited number of seconds for an answer. If the user didn’t answer within that time,
              the changes will be saved automatically and the question window closed.
              You can sete the number of seconds in the Time to wait for answer field.

	Retain log files — In this section you could set
              your preferences about the log files using the provided radio buttons.
	Never — Disable the creation of log files.

	For: — Enter a specific number of days for which keep the files.

	Forever — Disable the auto deletion of log files; retains the log files forever.







	Search Dialog
	New search limit: — Defaults to "new
              search" if fewer than this number of items is returned.







Online Banking



Figure 10.6. The Preferences — Online Banking tab
[image: The Online Banking tab]




	QIF Import
	Show documentation — The first time you
              use the QIF importer you may
              notice that the importer has detailed instructions on how to import
              a file. Once you have become familiar with using the importer, you
              might want to turn off this option. Turning off the option gives you
              less detail in the importer screens.

	Default transaction status (overridden by the status given by the QIF file) —
              In this section you could set the default status for imported transactions using the provided 
              self-explainingradio buttons:
	Not cleared (Default)

	Cleared

	Reconciled







	Generic Importer
	Enable skip transaction action — Enable the SKIP
              action in the transaction matcher. If enabled, a transaction whose best match’s score
              is in the yellow zone (above the Auto-ADD threshold but below the Auto-CLEAR threshold)
              will be skipped by default.

	Enable update match action — Enable the UPDATE AND RECONCILE
              action in the transaction matcher. If enabled, a transaction whose best match’s score is 
              above the Auto-CLEAR threshold and has a different date or amount than the matching existing 
              transaction will cause the existing transaction to be updated and cleared by default.

	Use Bayesian matching — Use Bayesian
               algorithms to match new transactions with existing accounts.

	Match display threshold — The minimal
              score a potential match must have to be displayed in the match
              list.

	Auto-add threshold — A transaction whose
              best match’s score is in the red zone (above display threshold, but
              below or equal to Auto-add threshold) will be added by
              default.

	Auto-clear threshold — A transaction
              whose best match’s score is in the green zone (above or equal to
              Auto-clear threshold) will be cleared by default.

	Commercial ATM fees threshold —
              In some places commercial ATMs (not
              belonging to a financial institution) are installed in places like convenience
              store.  These ATM add its fee directly to the amount instead of showing up as a
              separate transaction or in your monthly banking fees.  For example, you withdraw
              $100, and you are charged $101.50 plus Interac fees.  If you manually entered
              that $100, the amounts won’t match.  You should set this to whatever is the
              maximum such fee in your area (in units of your local currency), so the
              transaction will be recognized as a match by 
              GnuCash.

	Automatically create new commodities — Enables the 
              automatic creation of new commodities if any unknown commodity is encountered during 
              import. If not enabled, the user will be asked what to do with each unknown commodity.




	Online Banking
Note
This section is shown only if GnuCash is compiled with
          Aqbanking and HBCI support.

	Close log window when finished — Close the log window 
              when the operation is completed.

	Remember PIN — Enable this option if you
              want GnuCash to remember the PIN you
              enter for online banking authentication.

	Verbose debug messages — Enable this option if you
              want GnuCash to show more information about the online
              banking operations.







Printing



Figure 10.7. The Preferences — Printing tab
[image: The Printing tab]




The Printing tab allows you to set
        some options that affect the printing on paper of
        checks.
	Print date format — Enable this option
          if you want to print on the check, below the actual date, its format in 8 point type.
          

	Print blocking chars — Enable this option to print
          a series of three asterisks before and after each text field in the check.

	Default font: — Click the button on the left to open
          a Pick a Font screen in which you can customize the font
          that will be used to print checks.




Register



Figure 10.8. The Preferences — Register tab
[image: The Register tab]




	Actions
	'Enter' moves to blank transaction — If
              selected, move the cursor to the blank transaction at the end of the register
              after the user presses the Enter key. Otherwise the cursor will be moved
              down one row.

	Auto-raise lists — If selected, all lists
              will automatically be expanded when input focus is in the list
              field.

	Tab order includes Transfer on Memorised Transaction — 
              If selected, when the transaction is auto filled, pressing the 
              Tab key in the register the cursor’s jump 
              will include the Transfer field.




	Reconciling
	Check cleared transactions — If selected,
              automatically check off cleared transactions when
              reconciling.

	Automatic interest transfer — If
              selected, prior to reconciling an account which charges or pays
              interest, prompt the user to enter a transaction for the interest
              charge or payment. Currently only enabled for Bank, Credit, Mutual,
              Asset, Receivable, Payable, and Liability accounts.

	Automatic credit card payment — If
              selected, after reconciling a credit card statement, prompt the user
              to enter a credit card payment.

	Always reconcile to today — If
              selected, always open the reconcile screen with today’s date for
              statement date, regardless of previous reconciliation.




	Graphics
	Use system theme colors — If selected, 
              the system color theme will be applied to register windows. Otherwise
              the original GnuCash register color will be used.

	Double mode colors alternate with
              transactions — If selected, configures the register
              window to alternate between the primary and secondary colors with
              each transaction, instead of each row.

	Draw horizontal lines between rows — If
              selected, GnuCash will draw a horizontal line between each
              row.

	Draw vertical lines between columns — If
              selected, GnuCash will draw a vertical line between the cells in
              each row.







Register Defaults



Figure 10.9. The Preferences — Register Defaults tab
[image: The Register Defaults tab]




The Register Defaults tab
        preferences affect the behavior of the transaction register
        windows.
	Default Style
Here you can choose from 3
          different styles for register windows:
            
	Basic ledger — Show all transactions on one line. (Two in double line
               mode.)

	Auto-split ledger — Automatically expand the current transaction to show
               all splits.  All other transactions are shown on one line. (Two in double line
               mode.)

	Transaction journal — All transactions are expanded to show all splits.
              




            

	Other Defaults
	Register opens in a new window — If
              selected, register will be in a separate window instead of in a
              tab.

	Double line mode — If selected, show two
              lines of information for each transaction instead of one.

	Only display leaf account names — If selected, only the name of the leaf
              accounts will be displayed in the Account selection popup.
              The default behavoir is to display the full account name including the path in the account tree.
Warning

                Enabling this option implies that you use unique leaf account names.
                


	Number of transactions — How many
              transactions to show in a register. Set to 0 to show all transactions.







Reports



Figure 10.10. The Preferences — Reports tab
[image: The Reports tab]




The Reports tab preferences affect
        the behavior of GnuCash
        reports.
	Default Report Currency — This item
          determines which currency will be used by default when creating
          reports. You can choose:
	Locale — Use the system locale currency for all 
             newly created reports.

	Choose — Use the specified currency for all 
             newly created reports.




	Location
	Report opens in a new window — if you select this option, the
               reports will open up in a new window, instead of in a tab.







Scheduled Transactions



Figure 10.11. The Preferences — Scheduled Transactions tab
[image: The Scheduled Transactions tab]




The Scheduled Transactions tab
        preferences affect the behavior of
        GnuCash for scheduling transactions.
        More information about scheduled transactions can be found in
        the section called “Scheduling Transactions”.
	Since Last Run Dialog
	Run when data file opened — If selected,
              the Since Last Run screen will appear on GnuCash start-up (or
              rather when GnuCash opens the file).
              




	Transaction Editor Defaults
	Auto-Create new transactions — If
              selected, new scheduled transactions will automatically be entered
              into the register. If the auto-create option is enabled, you could also check
              Notify before transactions are created so that you will be
              able to confirm creating the transactions.

	Create in advance — The default
              number of days in advance to create the registered scheduled
              transactions.

	Remind in advance — The default
              number of days in advance to remind on new scheduled
              transactions.







Windows



Figure 10.12. The Preferences — Windows tab
[image: The Windows tab]




	Window Geometry
	Save window size and position — If
              selected, next time GnuCash starts will re-use the windows size
              and position configured in the last run.




	Tabs
	Show close button on notebook tabs — Adds
              a small close icon on each tab, to make it easier to close the
              various tabs.

	Bring the most recent tab to the front — If
              selected, the newly created tab will be shown over the other tabs.

	Width: — The width of tab label 
              expressed in characters.
              
Note
If the text in the tab is longer than this value 
                (the test is approximate) then the tab label will have the middle cut 
                and replaced with an ellipsis.
                


              




	Tab Position
Position the tabs at the
          Top (default), Bottom,
          Left or Right.

	Summary Bar Position
Position the Summary Bar at the
          Top or at the Bottom (default) of
          the GnuCash main window.





Changing Style Sheets



GnuCash has four default style sheets for web-page reports. These style sheets can
       be altered by using the HTML Style Sheets editor. To access the editor go to Edit → Style Sheets...
Using the Style Sheet Editor you may display/modify the setting of a Style
       Sheet.
Note
Changing the Style Sheet will change the appearance of all reports
       that have selected that Style Sheet. A Reload is required to view the changes, if
       the report(s) are currently displayed.

To add a new Style Sheet click the New... button in the Style Sheet pane.
       The New Style Sheet dialog will appear. Fill in the name field with 
       the name of the new Style Sheet and choose a template. To remove a Style Sheet select the Style Sheet from
       the list and click Delete.
Default Style Sheet



The Default Style Sheet has four tabs to alter the appearance of 
         reports utilizing it, Colors, Fonts, General and Tables. 
Colors Tab



	Alternate Table Cell Color: Opens the 
               color picker to choose a color that will be applied to alternate
               table rows.




Fonts Tab



	Title: Select the font and size for 
               Titles.

	Account Link: Select the font and size 
               for Account Links.

	Number Cell: Select the font and size 
               for Number Cells.

	Negative Values in Red: Select to have
               negative values displayed in red.

	Text Cell: Select the font and size 
               for Text Cells.

	Total Number Cell: Select the font and 
               size for Total Number Cells.

	Total Label Cell: Select the font and
               size for Total Label Cells.

	Centered Label Cell: Select the font and
               size for Centered Label Cells.




General Tab



	Background Color: Opens the color picker 
               to choose a new background color.

	Background Pixmap: Use the Browse button 
               to select a picture to use as the background in reports.

	Enable Links: Select this to enable 
               blue hyperlinks in reports.




Tables Tab



	Table cell spacing: Sets the space between table
               cells

	Table cell padding: Sets the space 
               between table cell edges and contents

	Table border width: Sets the width of 
               the borders on tables.





Easy Style Sheet



The Easy Style Sheet has five tabs to alter the appearance of 
         reports: Colors, Fonts, General, Images and Tables.
Colors



	Background Color: Opens the color picker 
               to choose a new background color.

	Text Color: Opens the color picker to 
               choose a new text color.

	Text Cell Color: Opens the color picker
               to choose a new text cell color.

	Link Color: Opens the color picker to 
               choose a new link color.

	Alternate Table Cell Color: Opens the 
               color picker to choose a new color for alternate table rows.

	Subheading/Subtotal Cell Color: Opens 
               the color picker to choose a new color for subheading/subtotal 
               table rows.

	Sub-subheading/total Cell Color: Opens 
               the color picker to choose a new color for sub-subheading/total 
               table rows.

	Grand Total Cell Color: Opens the color 
               picker to choose a new color for grand total rows.




Fonts



	Title: Select the font and size for 
               Titles.

	Account Link: Select the font and size 
               for Account Links.

	Number Cell: Select the font and size 
               for Number Cells.

	Negative Values in Red: Select to have
               negative values displayed in red.

	Number Header: Select the font and size 
               for Number Header table rows.

	Text Cell: Select the font and size 
               for Text Cells.

	Total Number Cell: Select the font and 
               size for Total Number Cells.

	Total Label Cell: Select the font and
               size for Total Label Cells.

	Centered Label Cell: Select the font and
               size for Centered Label Cells.




General



	Preparer: Name of the person preparing 
               the report.
              

	Prepared for: Name of Organization or Company the
               report is prepared for.

	Show preparer info: Show the Preparer information in
               the report.

	Enable Links: Select this to enable blue hyperlinks
               in reports.




Images



	Background Tile: Use the Browse button to select a
               picture to use as the background in reports. The Clear button will clear the
               selection.
              

	Heading Banner: Use the Browse button to select a
               picture to use as the heading in reports.  The Clear button will clear the
               selection.

	Heading Alignment: Select from pull-down list; Left,
               Right, Center, to specify the alignment of the banner at top of report(s).

	Logo: Use the Browse button to select a picture to
               use as the logo in reports.  The Clear button will clear the selection.




Tables



	Table cell spacing: Sets the space between table
               cells

	Table cell padding: Sets the space 
               between table cell edges and contents

	Table border width: Sets the width of the borders on
               tables.





Footer Style Sheet



The Footer Style Sheet has the same five tabs to alter the 
         appearance of reports as the Easy Style Sheets: Colors, Fonts, General, 
         Images and Tables.
Colors



	Background Color: Opens the color picker 
               to choose a new background color.

	Text Color: Opens the color picker to 
               choose a new text color.

	Text Cell Color: Opens the color picker
               to choose a new text cell color.

	Link Color: Opens the color picker to 
               choose a new link color.

	Alternate Table Cell Color: Opens the 
               color picker to choose a new color for alternate table rows.

	Subheading/Subtotal Cell Color: Opens 
               the color picker to choose a new color for subheading/subtotal 
               table rows.

	Sub-subheading/total Cell Color: Opens 
               the color picker to choose a new color for sub-subheading/total 
               table rows.

	Grand Total Cell Color: Opens the color 
               picker to choose a new color for grand total rows.




Fonts



	Title: Select the font and size for 
               Titles.

	Account Link: Select the font and size 
               for Account Links.

	Number Cell: Select the font and size 
               for Number Cells.

	Negative Values in Red: Select to have
               negative values displayed in red.

	Number Header: Select the font and size 
               for Number Header table rows.

	Text Cell: Select the font and size 
               for Text Cells.

	Total Number Cell: Select the font and 
               size for Total Number Cells.

	Total Label Cell: Select the font and
               size for Total Label Cells.

	Centered Label Cell: Select the font and
               size for Centered Label Cells.




General



	Preparer: Name of the person preparing 
               the report.
              

	Prepared for: Name of Organization or Company the
               report is prepared for.

	Show preparer info: Show the Preparer information in
               the report.

	Enable Links: Select this to enable blue hyperlinks
               in reports.

	Footer: Text to be included in report
               footer.




Images



	Background Tile: Use the Browse button to select a
               picture to use as the background in reports. The Clear button will clear the
               selection.
              

	Heading Banner: Use the Browse button to select a
               picture to use as the heading in reports.  The Clear button will clear the
               selection.

	Heading Alignment: Select from pull-down list; Left,
               Right, Center, to specify the alignment of the banner at top of report(s).

	Logo: Use the Browse button to select a picture to
               use as the logo in reports.  The Clear button will clear the selection.




Tables



	Table cell spacing: Sets the space between table
               cells

	Table cell padding: Sets the space 
               between table cell edges and contents

	Table border width: Sets the width of
               the borders on tables.





Technicolor Style Sheet



The Technicolor Style Sheet has has five tabs to alter the 
         appearance of reports: Colors, Fonts, General, Images and Tables.
Colors



	Background Color: Opens the color picker 
               to choose a new background color.

	Text Color: Opens the color picker to 
               choose a new text color.

	Text Cell Color: Opens the color picker
               to choose a new text cell color.

	Link Color: Opens the color picker to 
               choose a new link color.

	Alternate Table Cell Color: Opens the 
               color picker to choose a new color for alternate table rows.

	Subheading/Subtotal Cell Color: Opens 
               the color picker to choose a new color for subheading/subtotal 
               table rows.

	Sub-subheading/total Cell Color: Opens 
               the color picker to choose a new color for sub-subheading/total 
               table rows.

	Grand Total Cell Color: Opens the color 
               picker to choose a new color for grand total rows.




Fonts



	Title: Select the font and size for 
               Titles.

	Account Link: Select the font and size 
               for Account Links.

	Number Cell: Select the font and size 
               for Number Cells.

	Negative Values in Red: Select to have
               negative values displayed in red.

	Number Header: Select the font and size 
               for Number Header table rows.

	Text Cell: Select the font and size 
               for Text Cells.

	Total Number Cell: Select the font and 
               size for Total Number Cells.

	Total Label Cell: Select the font and
               size for Total Label Cells.

	Centered Label Cell: Select the font and
               size for Centered Label Cells.




General



	Preparer: Name of the person preparing the report.
              

	Prepared for: Name of Organization or Company the
               report is prepared for.
              

	Show preparer info: Show the Preparer information in
               the report.

	Enable Links: Select this to enable blue hyperlinks in
               reports.




Images



	Background Tile: Use the Browse button to select a
               picture to use as the background in reports.  The Clear button will clear the
               selection.

	Heading Banner: Use the Browse button to select a
               picture to use as the heading in reports.  The Clear button will clear the
               selection.

	Heading Alignment: Select from pull-down list; Left,
               Right, Center, to specify the alignment of the banner at top of report(s).

	Logo: Use the Browse button to select a picture to use
               as the logo in reports.  The Clear button will clear the selection.




Tables



	Table cell spacing: Sets the space between table
               cells

	Table cell padding: Sets the space 
               between table cell edges and cell contents

	Table border width: Sets the width of the borders on
               tables.






1. APPLICABILITY AND DEFINITIONS




      This License applies to any manual or other work that contains a
      notice placed by the copyright holder saying it can be
      distributed under the terms of this License. The
      “Document”, below, refers to any such manual or
      work. Any member of the public is a licensee, and is addressed
      as “you”.
    

      A “Modified Version” of the Document means any work
      containing the Document or a portion of it, either copied
      verbatim, or with modifications and/or translated into another
      language.
    

      A “Secondary Section” is a named appendix or a
      front-matter section of the Document that deals exclusively
      with the relationship of the publishers or authors of the
      Document to the Document’s overall subject (or to related
      matters) and contains nothing that could fall directly within
      that overall subject. (For example, if the Document is in part a
      textbook of mathematics, a Secondary Section may not explain any
      mathematics.)  The relationship could be a matter of historical
      connection with the subject or with related matters, or of
      legal, commercial, philosophical, ethical or political position
      regarding them.
    

      The “Invariant Sections” are certain  Secondary Sections whose titles
      are designated, as being those of Invariant Sections, in the
      notice that says that the Document is released under this
      License.
    

      The “Cover Texts” are certain short passages of
      text that are listed, as Front-Cover Texts or Back-Cover Texts,
      in the notice that says that the Document is released under this
      License.
    

      A “Transparent” copy of the  Document means a machine-readable
      copy, represented in a format whose specification is available
      to the general public, whose contents can be viewed and edited
      directly and straightforwardly with generic text editors or (for
      images composed of pixels) generic paint programs or (for
      drawings) some widely available drawing editor, and that is
      suitable for input to text formatters or for automatic
      translation to a variety of formats suitable for input to text
      formatters. A copy made in an otherwise Transparent file format
      whose markup has been designed to thwart or discourage
      subsequent modification by readers is not Transparent.  A copy
      that is not “Transparent” is called
      “Opaque”.
    

      Examples of suitable formats for Transparent copies include
      plain ASCII without markup, Texinfo input format, LaTeX input
      format, SGML or XML using a publicly available DTD, and
      standard-conforming simple HTML designed for human
      modification. Opaque formats include PostScript, PDF,
      proprietary formats that can be read and edited only by
      proprietary word processors, SGML or XML for which the DTD
      and/or processing tools are not generally available, and the
      machine-generated HTML produced by some word processors for
      output purposes only.
    

      The “Title Page” means, for a printed book, the
      title page itself, plus such following pages as are needed to
      hold, legibly, the material this License requires to appear in
      the title page. For works in formats which do not have any title
      page as such, “Title Page” means the text near the
      most prominent appearance of the work’s title, preceding the
      beginning of the body of the text.
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